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NEW QUESTION 1
- (Exam Topic 1)
You need to provide all app components of the application to Tailwind Traders. What should you do?

A. Package the application and flow components into a single solution for export.

B. Run the app checker and flow checker prior to publishing each component for export.

C. Export each component separately but use the same version number for each component.
D. Publish the application and flow solutions at the same time before exporting each one.

Answer: B

Explanation:

Scenario: When identifying versions of the app solution, all dependencies, entities, and user interfaces components must be identified to avoid any unintentional
issues caused by reverting individual components to a previous version.

Power Apps has added components to the rule set that encourages best practices in the Power Apps Checker. You can check your canvas apps and flows that
are included in solutions and then review all issues in a single, consolidated report.

Reference:

https://docs.microsoft.com/en-us/power-platform-release-plan/2019wave2/microsoft-powerapps/checker-include

NEW QUESTION 2

- (Exam Topic 1)

You need to roll back the mobile app to an earlier version.

What should you do? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Box 1: View the sessions details page for the app in Power Apps Studio

Use PowerApps Studio, select the App, and choose and you will be directed to the app’s Versions tab in PowerApps portal. There should be one version marked
Live.

Box 2: Select Restore on the previous version of the app. Restore an app from your account

Open powerapps.com, and then click or tap Apps in the left navigation bar.

Near the right edge, click or tap the info icon for the app that you want to restore.

Click or tap the Versions tab, and then click or tap Restore for the version that you want to restore.

Reference:
https://powerapps.microsoft.com/sk-sk/blog/saveandpublish/ https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/restore-an-app

NEW QUESTION 3

- (Exam Topic 2)

You need to implement the change requested by the operations manager. Which control should you use?
BF70D5D

A. Camera

B. Shape

C. Add picture
D. Image

Answer: D

Explanation:

Scenario: The operations manager asks that the time tracking app display the employee’s photo once they have scanned their badge.
Image control in Power Apps is a control that shows an image from, for example, a local file or a data source. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/controls/control-image

NEW QUESTION 4

- (Exam Topic 3)

You are creating a model-driven app that allows users to create and edit a list of existing accounts. You need to display a list of all active accounts.
Which user interface components should you use?

A. view

B. gallery

C. data table
D. form
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Answer: C

Explanation:

Imagine that you have a collection of data (such as a list sales orders, a set of service tickets, or a directory of contacts), and that you want to show this data in
your Microsoft PowerApps app in a tabular format, where each column represents a field and each row represents a record. In the past, you might have been able
to roughly simulate this visualization, although the process required some effort. However, we’ve been listening to your requests and are happy to announce that
you can now quickly and easily achieve this very typical visualization by using the new Data table control that has been recently added to PowerApps.

Reference:

https://powerapps.microsoft.com/fr-fr/blog/introducing-the-data-table-control/

NEW QUESTION 5

- (Exam Topic 3)

You create a canvas app.

A user is not able to determine which field currently has focus. You run App checker to identify errors. You need to verify that the focused border thickness is set to
a value greater than zero.

Which section of the App checker results should you check?

A. Rules

B. Performance
C. Accessibility
D. Runtime

Answer: C

Explanation:

The Accessibility checker classifies each issue as an error, a warning, or a tip based the issue's severity. Issues include:

Focus isn't showing

When the FocusBorderThickness of a control is set to 0. It is good practice to ensure a proper color-contrast ratio between the focus border and the control itself
so it's clearly visible.

Reference:

https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/accessibility-checker

NEW QUESTION 6

- (Exam Topic 3)

You are configuring a new Common Data Service environment by using the Power Apps Maker portal. You need to create an entity that uses the prefix xyz.
Which four actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/common-data-service/data-platform-create-entity

NEW QUESTION 7

- (Exam Topic 3)

You create a canvas app within a Power Platform environment.

You need to identify potential accessibility issues for the canvas app before making the app available to other users.
Which tool should you use?

A. Portal Checker
B. App Checker
C. Solution Checker

Answer: B
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Explanation:
Find accessibility issues
* 1. In the upper-right corner of Power Apps Studio, select the icon for the App checker.

* 2. In the menu that appears, select Accessibility.

A list of issues appears, sorted first by severity and then by screen. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/accessibility-checker

NEW QUESTION 8

- (Exam Topic 3)

You are an app builder for a medical office. The medical office uses activities to book appointments and business process flows to track patient status. The
cleaning staff wants the app to connect directly to a Microsoft Excel workbook to track cleaning tasks. The office does not have access to reporting tools including
Power BI.

You need to create apps for the following groups of users. Apps must not require customizations or the use of additional products.

Which type of app should you build for each group? To answer, drag the appropriate app types to the correct groups. Each app type may be used once, more than
once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Reference:

https://docs.microsoft.com/en-us/powerapps/maker/model-driven-apps/embedded-canvas-app-guidelines https://global.hitachi-solutions.com/blog/canvas-vs-
model-driven-apps

NEW QUESTION 9

- (Exam Topic 3)

You are configuring security to enable users to analyze data by using Microsoft Excel templates.

You create a security role named TemplateAdministrator and configure the role as shown below and assign the role to a user named User1.

Use the drop-down menus to select the answer choice that answers each question based on the information presented in the graphic.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation:

NEW QUESTION 10

- (Exam Topic 3)

You need to set the value for a global variable named RunningTotal to 5 and navigate to the previous screen named MainScreen.
Which formula should you use?

A. UpdateContext( { RunningTotal: 5 } ); Navigate( MainScreen, ScreenTransition.Cover, RunningTotal );
B. If( Value(TextBox1.Text) >= 0, (Set( RunningTotal, 5); Back();), Color.Green )

C. UpdateContext( { RunningTotal:5 } ); Back()

D. Set( RunningTotal, 5 ); Back();

Answer: D

Explanation:

You set the value of the global variable with the Set function. Set( MyVar, 1) sets the global variable MyVar to a value of 1.

Use the Back and Navigate function to change which screen is displayed. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/working-with-variables https://docs.microsoft.com/en-us/powerapps/maker/canvas-
apps/functions/function-navigate

NEW QUESTION 10

- (Exam Topic 3)

You create a canvas app.

You need to make the app available to other people in your company.

What are two possible ways to achieve the goal? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. Grant access to individual users in your company.

B. Share the app with a Microsoft Exchange distribution list.

C. Grant access to a Microsoft Teams team.

D. Share the app with a Microsoft Azure Active Directory security group.

Answer: AD

Explanation:

After you build a canvas app that addresses a business need, specify which users in your organization can run the app and which can modify and even reshare it.
Specify each user by name, or specify a security group in Azure Active Directory.

Reference:

https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/share-app

NEW QUESTION 13

- (Exam Topic 3)

You have the following Common Data Service entities: BusinessContracts and BusinessAccounts. You need to configure an N:N relationship between the two
entities.

Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.
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A. Mastered
B. Not Mastered

Answer: A

Explanation:

Step 1: Open the relationship tab of the BusinessContracts entity. View entity relationships

From the Power Apps portal, select either Model-driven or Canvas design mode. Select Data > Entities and select the entity that has the relationships you want to
view. With the Relationships tab selected, you can select the following views:

Step 2: Select Add relationship.. Create relationships

While viewing entity relationships, in the command bar, select Add relationship and choose Many-to-many. Step 3: Select the BusinessAccounts entity as the
related entity.

Reference:

https://docs.microsoft.com/en-us/powerapps/maker/common-data-service/create-edit-nn-relationships-portal

NEW QUESTION 16

- (Exam Topic 3)

You have a solution that contains a Power Automate flow, an environment variable, and a model-driven app. Which three steps should you perform in sequence?
To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Step 1: Adjust the version number. Step 2: Select the managed solution.

Managed Solution: A managed solution is a finalized solution that can be distributed and installed. They are created by exporting an unmanaged solution by setting
restrictions to prevent any further customizations. The whole point of Managed is locking down the Component states so they cannot be edited. Deleting the
Managed Solution will remove all its customisations as well as data contained. Managed Solutions become read only once deployed so they cannot be
manipulated.

Step 3: Publish all changes. Reference:

https://powerusers.microsoft.com/t5/Power-Apps-Pro-Dev-1SV/Managed-vs-Unmanaged/td-p/495685

NEW QUESTION 19

- (Exam Topic 3)

A company uses Power Automate and Power Apps to streamline business processes. You need to use Al Builder to analyze customer reviews of the company’s
products.

In which order should you perform the actions? To answer, move all actions from the list of actions to the answer area and arrange them in the correct order.

A. Mastered
B. Not Mastered

Answer: A

Explanation:

Step 1: Connect data to the model.

First create an Al Builder form processing model for the customer reviews you want to process.
Step 2: Train the model. Step 3: Publish the model.

Step 4: Use the model in a Power Automate flow.
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Once you train and publish the model, create a solution-aware flow in Power Automate. Reference:
https://powerapps.microsoft.com/en-us/blog/introducing-simplified-ai-builder-experience-in-power-automate/

NEW QUESTION 22

- (Exam Topic 3)

You are designing a canvas app that will be used by all users including users who have vision impairments. Which outcome is achieved by each action? To
answer, drag the appropriate outcomes to the correct actions.

Each outcome may be used once, more than once, or not at all. You may need to drag the split bar between

panes or scroll to view content.

NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Reference:
https://docs.microsoft.com/sv-se/powerapps/maker/canvas-apps/accessible-apps

NEW QUESTION 24

- (Exam Topic 3)

You are an app maker. You are creating a canvas app. You do not have access to Power BI.

You need to add charts to the app.

Which three chart types can you add directly to the canvas app? Each correct answer presents a complete solution.
NOTE: Each correct selection is worth one point.

A. pie

B. area
C. funnel
D. column
E. line

Answer: ADE

Explanation:

You can use line charts, pie charts, and bar charts to display your data in a canvas app. Add a bar chart to display your data:
* 1. On the Home tab, add a screen.

* 2. On the Insert tab, select Charts, and then select Column Chart. Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/use-line-pie-bar-chart

NEW QUESTION 26

- (Exam Topic 3)

You are creating a multi-page canvas app that loads tabular data from an external data source. Once loaded, the data must be available to all screens within the
canvas app.

You need to reduce the number of times that the app must retrieve data from the data source. Which two data stores can you use? Each correct answer presents
a complete solution. NOTE: Each correct selection is worth one point.

A. parameter

B. global variable

C. collection

D. environment variable

Answer: CD

Explanation:
Reference:
https://docs.microsoft.com/en-us/powerapps/maker/canvas-apps/working-with-data-sources

NEW QUESTION 28

- (Exam Topic 3)

You create a custom field on the Account entity.

Members of TeamA must have full access to the field. Members of TeamB must have no access to the field. You need to configure security.

Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.
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A. Mastered
B. Not Mastered

Answer: A

Explanation:

Step 1: Enable field security for the field

Step 2: Create a field security profile and set all the permissions for the custom attribute to Yes. Step 3: Add TeamA to the field security profile.

Note: Field-level security is available for the default fields on most out-of-box entities, custom fields, and custom fields on custom entities. Field-level security is
managed by the security profiles. To implement field-level security, a system administrator performs the following tasks.

Enable field security on one or more fields for a given entity.
Associate one more existing security profiles, or create one or more new security profiles to grant the appropriate access to specific users or teams.

NEW QUESTION 29

- (Exam Topic 3)

You create a canvas app for technicians at a computer store. You assign technicians cases to work on. The technicians update cases at the end of customer site
Visit.

The manager wants the technicians to sell warranties to the customers. If a customer agrees to purchase a warranty, technicians use the canvas app to
immediately alert the sales team, and then the technician records details about the warranty into the app.

You need to create a flow to alert the sales team. Which type of trigger should you use?

A. Flow button for mobile
B. Power Apps

C. Office 365 Outlook

D. Common Data Service

Answer: A

Explanation:

Create a button flow to run routine tasks by simply tapping a button. Customize your flow by allowing the user to provide specific details that will be used when the
flow runs.

Note: There are many repetitive tasks that we all wish we could run with just a tap of a button. For example, you may need to quickly email your team to remind
them to join the daily team sync, or you may want to start a new Visual Studio Codespaces build of your code base after you've been notified that there are no
more checkins planned for the day. Button flows allow you to accomplish these and many other tasks simply by tapping a button on your mobile device.
Reference:

https://docs.microsoft.com/en-us/power-automate/button-flow-with-user-input-tokens

NEW QUESTION 31

- (Exam Topic 3)

Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.

After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.

You build a canvas app for a manufacturing company. The company receives parts and materials from many vendors. You create a form to collect information
from packing slips.

Receivers must be able to take a picture of packing slips to receive materials instead of manually entering data in the app.

You need to ensure that users can scan packing slip information into the form. Proposed solution: Use an Entity Extraction model.

Does the solution meet the goal?

A. Yes
B. No

Answer: A

Explanation:

Al Builder entity extraction models recognize specific data in the text that you target based on your business needs.

The model identifies key elements in the text and then classifies them into predefined categories. This can help you transform unstructured data into structured
data that's machine-readable. You can then apply processing to retrieve information, extract facts, and answer questions.

Note: Create a canvas app and add the text recognizer Al Builder component to your screen. This component takes a photo or loads an image from the local
device, and then processes it to detect and extract text based on the text recognition prebuilt model. If it detects text in the image, the component outputs the text
and identifies the instances by showing a rectangle for each instance in the image.

Reference:

https://knowledgefrommanish.com/powerplatform/ai-builder-entity-extraction-ai-model/ https://docs.microsoft.com/en-us/ai-builder/prebuilt-text-recognizer-
component-in-powerapps

NEW QUESTION 33

- (Exam Topic 3)

You are an app maker.

You want to create apps and track customizations as part of the default solution. You need to determine the impact of performing the work in the default solution.
What should you conclude?

A. The default solution does not contain all components and customizations from all solutions in the environment.
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B. The prefix used when creating components as part of the default solution can be set to a specific value.
C. The default solution cannot be exported and distributed to another environment.

Answer: C

Explanation:

Default Solution. This is a special solution that contains all components in the system. The default solution is useful for discovering all the components and
configurations in your system.

Why you shouldn't use the default solutions to manage customizations

There are a few reasons why you shouldn't create apps and make customizations in either of the default solutions:

The default solution can't be exported; therefore, you can't distribute the default solution to another

environment.

The default solution contains all components and customizations from all solutions in the environment.

By default, all enabled users can create apps and customize components in the Common Data Services Default Solution.

It's difficult to locate or identify the customizations you've made in the environment by using either default solution.

When you use either default solution to create components, you'll also use the default publisher assigned to the solution. This often results in the wrong publisher
prefix being applied to some components.

Reference:

https://docs.microsoft.com/en-us/power-platform/alm/use-solutions-for-your-customizations

NEW QUESTION 34
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